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Introduction
THE INTERNET used to hate commerce. In 1991, when I

first connected to the Net, it was still dominated by
academics, students, and other university types,

especially those in the sciences and engineering. They were
overwhelmingly male, highly educated, and accustomed to
the Internet as it had been for three decades: a forum for
exchanging ideas, for research, for argument, and for fun—
but definitely not for business.

At the time, anyone posting an advertisement for anything other than a
personal sale (usually of computer equipment) risked being viciously “flamed”
with dozens of hateful E-mails. Of course, even at the beginning of this
decade, the Internet was merely a vast, seething sea of plain text. The graph-
ics-rich World Wide Web we know today didn’t exist. It was still just an idea
with interesting potential. I rather arrogantly predicted to my roommate that
business would never be welcome on the Internet.

Things change fast, and my prediction was totally wrong. As late as 1994, the
word “Internet” drew blank stares from most people. In the summer of 1995, I
saw a URL (a Web address) on a billboard for the first time—in Silicon Valley,
California, of course. By 1997, no advertisement was complete without one.

Now, businesses are moving to the World Wide Web at ferocious speed. Most
are still using it as a publicity vehicle, a way to put brochures online, to
provide information to customers, or to generate hype. But increasing num-
bers are selling online too. A new word has appeared: E-Commerce. It could
change everything.

By now, you’re probably considering putting your business online. People you
know may be saying that you should have a Web site. Your customers might
be asking when you’ll have one. You may already use E-mail. Still, you might
not be sure how to approach the challenge. After all, you’re busy enough
running your business without worrying about taking it onto the Net. Yet you
might worry about being left behind in the rush.

This guide will help you understand how E-Commerce on the Internet works
today, how it will work tomorrow, and how Maximizer software is designed to
help make it easy to build your own E-Commerce Web site, get it online,
maintain it yourself, and manage your customers in this new business me-
dium. Many of the Web sites and other references I mention in the text
(important and interesting ones are in boldface) are listed in the Appendix
so you can look at them yourself to learn more.

http://www.maximizer.com
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Part I: Understanding
E-Commerce

Beginnings: What is E-Commerce?
ELECTRONIC COMMERCE is nothing new. Credit cards have been processed by
computer since the ’60s; automated teller machines have been common since
the early ’80s. Banks haven’t needed to move money on paper for many years.
Large corporations, stockbrokers, and governments rarely write checks in
their day-to-day activities anymore.

What’s new is that, today, electronic commerce isn’t restricted to large organi-
zations. The Internet is a great information exchange, but private individuals
and companies can trade more than just information. Now they can exchange
money for goods and services. They can do business. That’s the new meaning
of E-Commerce.

The Net and the Web are just new places to do business
Each generation finds a new way to buy and sell. A century ago, most busi-
ness was conducted face-to-face at local specialty stores. Then came mail
order and catalogs, which brought lower prices but made shopping less
personal. Department stores and supermarkets put one roof over goods that
used to come from many small shops, and so drove some of those shops out of
business.

Telephone ordering made buying from catalogs even easier, but without
orders in writing, it was easier to make mistakes. Credit cards took some of
the risk and difficulty out of payment, while making it easier for buyers to go
into debt. Television brought the sales pitch into our living rooms—for better
and worse. ATMs made the after-work bank rush obsolete, yet now you might
have to pay to see a human teller at all.

E-Commerce is the newest way to buy and sell. Like those that came before,
it changes the rules and can seem intimidating. It encompasses a wide range
of transactions, from private E-mail sales to real-time online stock trading. It
has benefits, risks, and problems. But as in the past, smart people with good
products and services can reach new markets and succeed. While the technol-
ogy remains new, customers will be wary, but eventually E-Commerce will be
second nature to nearly everyone with access to a computer.
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E-Commerce is still commerce, and still about human beings
Since those World Wide Web addresses first started appearing on billboards
in 1995, the Web has come to dominate online life so much that it sometimes
seems that the Web is the Internet. However, they are not the same thing.
The Web is a graphical, fairly easy-to-use part of the Internet that requires a
complex infrastructure of servers, browser software, and knowledgeable
designers and programmers to work. The Internet, on the other hand, is a
worldwide mega-network of smaller, interconnected computer networks,
many sophisticated enough to be part of the Web, but some quite rudimen-
tary.

There are a lot of people, especially outside North America, who are con-
nected to the Internet but can’t browse the Web. Large numbers still only
have E-mail. In the new world of E-Commerce, any of those people, from San
Jose in California to San José in the Philippines, from New York to New
Guinea, could be your customer.

As we discuss the different technologies you can use to enhance your online
business (including those that come with Maximizer), remember that your
customers are still people, and they want to find people at your end too. They
might only be able to send E-mail or call you on the phone—or might just
prefer to. If they’d rather send a “snail mail” letter or visit you in person,
don’t let the technology get in their way. Doing business online requires that
you understand new things, but E-Commerce is just another way to do
business, and customers are still customers, however they come to you.

Questions:
Should my business be an E-business?

Don’t take your business onto the Internet just because you can, or
because other people say you should. Like any other market, try to
understand it first, and see if your business would benefit from being
online.

The first successful Internet E-Commerce businesses were computer hard-
ware and software firms, largely because it made sense to sell computer
equipment and programs online: in the early ’90s, chances were that anyone
on the Internet would know a fair bit about computers and would be willing
to try new things, and so might be interested in a new way of buying. Those
people would also be capable of setting up computers and software without
direct assistance. Selling software was an especially good match, since ven-
dors could even make demos available online for users to try before they
bought.

Today, some of the largest computer manufacturers, such as Dell, Gateway
2000, and Apple, sell their products online—and their sites have some of the
largest revenues. Thousands of software companies, from giants such as
Microsoft and Adobe to one-person firms without any products in retail
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stores, sell software profitably on the Internet. Buying software is one of the
easiest things to do on the Web.

Still, even though the E-Commerce industry is young, there are other suc-
cesses in fields that, at first glance, you might think wouldn’t be able to work
online. Amazon.com made such a splash with its huge online bookstore that
Barnes & Noble, a traditional bookseller’s chain, felt it had to scramble to
put up its own competing site. Online auctions such as eBay Internet
process tens of thousands of bids every day, making money from small com-
missions on each successful sale.

On the Web today, you can buy flowers and plant seeds, book an entire vaca-
tion, and even find a car dealer in your city who has the car you want at the
right price. Typically, two of the biggest money-making industries on the Web
are those that seem to make profits anywhere they can find space: gambling
and pornography. So far, unfortunately, churches and charities haven’t had
such luck.

Is E-Commerce for real yet?
Seeing the triumphs of the E-Commerce pioneers (and conveniently ignoring
many others who failed in their first online ventures), thousands of compa-
nies are launching their own E-Commerce enterprises right now. But the real
boom hasn’t hit yet.

Computer industry analysts at the International Data Corporation (IDC)
estimate that the number of users on the Net will quadruple from 1997 to
2002, from an estimated 82 million (about the population of the westernmost
United States) to 329 million (about the population of all of Western Europe).
More spectacularly, they speculate that Web E-Commerce transactions will
increase over 40 times during that period, from $8 billion (about the same as
the annual revenue of one of the top 10 computer manufacturers) to $333
billion (about as much the Gross National Product of Australia).

Computer Intelligence (CI) and Cyberdialogue, other technology analy-
sis firms, predict that 50% of all small U.S. companies will conduct business
online by the end of 1998. They claim that at the beginning of 1998 that
number was 37% (about 2.6 million businesses), already double the percent-
age only a year earlier. Half of the surveyed businesses that were already
online reported that their Web presence has improved their customer service,
and a quarter think their sites have boosted sales.

Of course, that also means that half of those businesses saw no change or
even a worsening of customer service. A full three-quarters can’t say that
their sales have improved simply because they’re on the Web. And when IDC
surveyed large businesses in the Fortune 500, they reported that their aver-
age cost for setting up an E-Commerce site was $600,000.

The statistics are simultaneously exhilarating and scary. E-Commerce is
poised for a big boom, but you don’t know whether you’ll be propelled ahead
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in the explosion or demolished by it—or whether you’ll have blown a lot of
money on your rocket, but still be tinkering when everyone else has already
reached Mars.

But because the Internet is such an unregulated and global marketplace,
rigorous research about it is difficult, and the statistics could be completely
wrong, or at least significantly off base. For example, estimates of the num-
ber of adults online in the United States in early 1998 range from 41 million
to 62 million—a margin of error of at least 20%. Predictions about when E-
Commerce will truly be accepted into the market mainstream vary from “it
already is” to “it won’t happen for at least five years.” And no one knows the
impact of the infamous Year 2000 Problem, when many mainframes, PCs,
and other computers might—or might not—get confused when they think the
year 2000 is really 1900 again.

What don’t the numbers tell you?
There are clearly some benefits that none of the numbers show, as well as
reasons to get involved with E-Commerce now before the rush really starts. If
E-Commerce is appropriate for your business, you should start early, be
aware of how the E-Commerce landscape is changing, and know roughly
when to expect the real boom to hit, so you can prepare accordingly.

1. Start early so you can be imperfect
When the Sears mail order catalog began many decades ago, its processing
and shipment center was chaotic, and the slips of paper used to track orders
frequently got lost or misfiled. Sears routinely delivered customers’ orders
ridiculously late, and often got them wrong even when they did arrive—you
might order a pair of shoes and receive a wood stove, for instance. Yet Sears
didn’t go broke, and when they finally did reorganize their catalog system,
the company became one of the sales success stories of the century.

You can learn from Sears. Since they were in the market early, there was
little competition, so when they made mistakes—even huge ones—there were
few other companies to take their customers away. They had time to work the
bugs out of their mail order system without going under.

Similarly, those who get into the E-Commerce market early—and it’s still
early—have the opportunity to be imperfect. You won’t have as big of a break
as Sears did, but if your site and your online customer service aren’t first-
class right off the mark, you’ll be able to find that out and adjust accordingly.
Since online sales are still in their infancy, your customers will probably give
you the benefit of the doubt while you work out your bugs.

Since you will have bugs to get rid of, and since it will take time to learn how
E-Commerce should work for you, it’s probably a good idea not to bet your
whole business on the Internet, unless you’re already so familiar with it that
you could have written this guide better than I have. Also, keep in mind that
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even the easiest to use, most comprehensive online store won’t make all its
sales online.

2. Many online sales still happen indirectly
Many people are still wary about spending money on the Internet. Many
others just prefer to talk to someone, either on the phone or face to face,
before they make a purchase. These people might still use your E-Commerce
site as a resource—they’ll use it to determine what you do, to find the exact
item or service they want and whether you provide it, to examine your prices,
and to get an impression of how reliable your business is. They may not tell
you they’ve checked you out online, so you may not be able to put hard num-
bers on the effect your E-Commerce efforts have on your “regular” sales, but
the effect will be there.

No matter how much changes in the next few years, these indirect sales will
stick around. Remember: even though over 80% of bank transactions are now
done through ATMs, over the phone, with online banking, and using other
electronic means, some people prefer to see a human teller whenever they
bank—and nearly everyone has to see a human teller sometime. In other
words, just because you’re involved in E-Commerce, don’t cut off your phone
line, then junk your fax machine and use it to wedge your doors shut.

3. More users mean more diversity – and more specialization
As more people get onto the Internet, it is diversifying—meaning, in part,
that while more people will be willing to buy online, there will remain others
who would prefer to visit your Web site, then phone, fax, or visit you to buy. A
large, diverse community of users also means that the Internet is specializ-
ing—so however obscure your products or services, you might find enough
customers online to make some money.

As I mentioned at the beginning of this guide, until a few years ago the
Internet was dominated by highly educated university types (and, outside of
North America, it still is). Today, North American Internet users remain on
average richer and more highly educated than the North American popula-
tion at large. That too is changing. At the end of 1997, the research firm
IntelliQuest reported that 25% of those online in the United States were
new to the Net within the previous year, and they more closely matched
typical income and educational profiles. So Middle America is getting online.

But as Middle America gets wired, so does Young America. And Middle-Aged
New Zealand. And Senior Citizen Israel. Each group has different interests.
Different age groups behave differently online too. According to the Internet
research firm +Plan, young adults spend their online time working and
entertaining themselves, while middle-aged people do research and get the
latest news. It’s no longer possible to target your site at everyone on the
World Wide Web, just as television advertisers can no longer hope to reach
the broad cross-section of people they used to on The Ed Sullivan Show.
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Don’t forget this increasing diversification and specialization: find a group on
which to focus your business, then determine the best ways to reach them.
Don’t think of E-Commerce as broadcasting. Think of it as “narrowcasting.”
As Annette Hamilton of the well-respected ZDNet Anchordesk online news
page put it, “think about ways to get narrow.”

4. There’s still time – but not a whole lot of it
So E-Commerce has begun to sink in. The big computer players are selling
online, as are a few other large companies and quite a few small ones. The
number of users online (a number no one quite knows) is growing (but no one
quite knows how fast). A huge boom in E-Commerce is almost certainly
coming, but when?

The best-researched estimates say that E-Commerce will hit the big time in
1999 or 2000. That appears to be about the time when several key things
should happen. Enough people’s Internet connections will be fast enough to
make “World Wide Wait” more of a joke, and less actual fact (although most
people online won’t have genuinely high-speed connections to the Net until
around 2003). Some standards should be established, not just for how trans-
actions are secured and payments accepted, but also for how customers will
submit that information and how they will identify themselves.

People will be able to access the Web (and buy products) from devices other
than personal computers, such as hand-held organizers, network computers,
information appliances, WebTV, gaming consoles, and more. There will be
more easy-to-use E-Commerce solutions (like Maximizer) that work for non-
technical people right out of the box. And, most importantly, enough busi-
nesses will be selling online—and will have worked out the bugs in their sales
systems—that customers can easily find what they want and comparison
shop, until E-Commerce seems as natural as buying by phone or in a store.

Still, that doesn’t leave you much time. As I write this guide, 1999 is only
eight months away. As you read it, 1999 may be just around the corner, or
already here. If you’re looking at selling to an international audience, the
window is slightly wider: according to Web researcher Jakob Nielsen,
Northern Europe, Australia, and New Zealand are about a year behind,
Central Europe and the major Asian Pacific Rim centers (such as Japan,
Singapore, South Korea, and Hong Kong) are about two years behind, and
Southern Europe and the rest of the world are at least three years behind.

Nevertheless, if you start planning now, you can have an effective E-Com-
merce presence online before everyone else on your block does—and with
luck, before your major competitors do.

Maximizer can help you achieve that goal. The rest of this guide explains the
state of E-Commerce today, the key things you need to do to make E-Com-
merce work, and how Maximizer’s new E-Commerce features can make those
tasks easier.
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Part II:
E-Commerce Today

GETTING YOUR BUSINESS selling online today requires some general Web knowl-
edge, some specific skills, and a few tools. Until very recently, it also required
you to learn hypertext markup language (HTML, the computer language
used to create Web pages), and maybe even how to program common gateway
interface (CGI) scripts on a Web server computer. Those skills, especially
HTML, are not especially difficult to learn for technically-minded people who
are interested in them, but many businesspeople like you are too busy run-
ning their businesses to become Web designers and script programmers as
well. Luckily, you don’t need to do that anymore.

You still need to be intelligent about your E-Commerce business decisions,
however. Online businesses continue to have overhead, although they may
not require physical offices or warehouses, and they take time to make work,
even if they are only a sideline to a successful traditional enterprise. Like
“normal” ones, E-Commerce businesses succeed or fail by the quality and
appropriateness of their products or services, how reasonable their prices are,
how convenient they are to buy from, and how well they are marketed.

The Internet is not some magical place where the rules are completely unlike
those in the rest of the world. You can apply much of what you know about
other kinds of business to E-Commerce—and you should. There are differ-
ences, however. The first thing you should do is ask a question.

Is your business appropriate for E-Commerce?
Pretty much any kind of enterprise can work on the Web. Some current E-
Commerce operations are global even if they have only one office, such as
small software companies that sell their products to anyone who wants to buy
them, wherever they are; others are more or less local, such as sites selling
tickets to entertainment events in a particular city, or products that are
restricted by law to their own state or country.

Some sell physical items which must be shipped to or picked up by custom-
ers—cars, books, plants, computers, and so on. Others sell information in one
form or another—downloadable software, digital photographs, articles by
subscription, and more. Still others sell services—writing and editing, ac-
counting, psychic advice, whatever. Chances are your business fits into one of
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these categories. Yet there are some for which E-Commerce might not work,
or for which it would take a lot of effort for very little return.

For example, if you’re already so busy that you can’t do any more work
yourself, and you’d rather not or can’t hire additional help, the extra toil of
putting up a Web site to attract more customers and sell more will be wasted,
since you won’t be able to handle any extra load—let alone the work of main-
taining your site.

If you are in a professional field with strict qualifying criteria and a well-
established, official or legally mandated procedure for getting customers,
such as medicine, dentistry, many aspects of law, or consulting, you might not
want a Web site where people can actually buy your services. You might
instead put up an informational one (if you want a site at all) from which you
can simply be contacted. After all, you don’t want patients using an auto-
mated system to schedule appendectomies for themselves when all they need
are some antacids.

On the other hand, if your business is extremely specialized, you might find a
lot of customers among the millions on the Web, where in your immediate
neighborhood there may not be enough to make your trade profitable. Even if
finding enough new customers online is unlikely, consider your relationships
with your suppliers: would they benefit from being able to work with you over
the Net instead of by phone, fax, and mail? Ask yourself whether your specific
enterprise can use an E-Commerce site profitably. Only if it can (and most
businesses should be able to), then forge ahead.

Elements of selling online
What do you need for E-Commerce today? You certainly need some
sort of Internet access. Although there are roundabout ways to
promote and sell your products or services online without having
regular Internet access yourself, that’s not really E-Commerce—it’s
just another way of advertising regular, “old-style” commerce. A key element
of E-Commerce is that, if they wish, your customers should be able to perform
an entire transaction—with the possible exception of actually having your
products or services delivered—online, either on a Web site or via E-mail.

Thus, for genuine E-Commerce, you should at least have an Internet E-mail
account (or access to one you can use for business), as well as your own
business Web site or, at a minimum, a single Web page.

E-mail is a killer – but not in a bad way
E-mail is the easiest Internet access to get, and it’s also pretty simple to
understand and use. Because of that, Jesse Berst, an online columnist who
helms the ZDNet Anchordesk Web site, calls E-mail “the Internet’s killer
app”—in other words, the one aspect of the Net that makes it an essential
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daily tool for a lot of people, much as telephones and fax machines have
become for businesses.

Berst’s is not an idle claim. According to researchers at the Yahoo! Internet
search site, 97% of the estimated 110 million people worldwide who are on
the Internet use E-mail. A full 90% of them check it at least once a week, and
two-thirds of those use it daily. 84% of Internet users surveyed in Georgia
Tech’s GVU 8th Web Survey said they couldn’t live without E-mail anymore.
56% have more than one E-mail account.

There are far more people with access to E-mail than to the World Wide Web.
Wired magazine estimates that E-mail usage is in fact growing faster than
Web usage. The technology has become so pervasive in the last couple of
years that no business card seems complete without an E-mail address, and a
New York Catholic Bishop has even proclaimed that “if Jesus were walking
the Earth today, I’m convinced He would have an E-mail address.”

If nothing else, your online customers will be able to reach you by E-mail for
inquiries, orders, and other correspondence, so you need an E-mail account
for them to contact. Although there are free Web-based E-mail services, and
many libraries and other public places have so-called Freenets where you can
get an E-mail account at no charge, using those services to run a business is
like having a pay phone as your office number.

You’d best get an E-mail account you can connect to directly from your home
or office computer using a modem. Such accounts can be bought for $20 or
less per month, either from a local or a national Internet Service Provider
(ISP). For its users in the United States, Maximizer even includes the AT&T
WorldNet Service sign-up package right in the box. You can find other ISPs
in your local telephone book under “Internet.” You can also discuss with your
ISP how to get a domain name for your business (such as yourowncompany.com)—
something I talk about in the next section.

If you’re worried that you might change Internet providers—and therefore E-
mail addresses—in the future; if you have several addresses already and use
different ones at different times; or if your E-mail address is hard to remem-
ber (such as 25567.krh@weirdo.gronknet.edu), you can try an E-mail forwarding
service such as Pobox, which gives you a permanent E-mail address (like
yourcompany@pobox.com) for an extra $15 per year. Messages sent to it are
redirected to any other E-mail address you specify, so you can safely put your
permanent forwarding service E-mail address on your business cards, flyers,
letterhead, and packaging.

By the way, that is something you should do. To be effective, your E-mail
address must be as much a part of your business identity as your telephone
number and mailing address. If people want to reach you by E-mail, there is
as yet no definitive equivalent to the telephone book in which they can find
your E-mail address, so have it close at hand for anyone who comes in contact
with you. Put it on everything from invoices to advertising, from storefront
signs to shopping bags.
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Once you get your E-mail address and promote it, make sure you check your
mail every day or two: the 60% of Internet users who use their E-mail every
day are used to quick response times. Many people who are online are also
more inclined to contact a business by E-mail than by telephone if they can. (I
am, for one.) Give your customers that option whenever possible. Maximizer’s
integration with major E-mail programs such as Microsoft Outlook and
Eudora Pro then makes it easy to manage your online relationships with
them.

Your Web site is your face
The World Wide Web has been the engine of the Internet’s explosive growth
since 1994. It began in the early 1990s as an exercise in creating hyperlinks
between pages of text at the CERN physics research facility in Europe, but
soon after that, Web browser software became capable of displaying graphics
too. Today, as an easy-to-use, graphical, point-and-click way of navigating
through billions of pages of information, the Web has become the face of the
Internet.

While E-mail is essential for being able to do E-Commerce at all, a Web site of
your own is the way to make your presence known to the world. Your Web site
can act as advertisement, brochure, catalog, storefront, order desk, and
service center at once. How it looks and works reflects on your business. On
the Net, E-mail is your voice, but your Web site is your face. It’s how people
decide whether to talk to you in the first place.

Putting up a Web site – the old way
Until now, putting up a Web site has been somewhat awkward. Many ISP
accounts not only give you an E-mail address, but also provide a small
amount of space on the ISP’s server computer on which you can put a Web
site, sometimes for an additional fee. Often the amount of space is fairly
limited, and you may also be charged extra if your site’s traffic (how much
information is sent to your visitors) exceeds a certain amount, measured in
megabytes (MB) of traffic per month.

Your ISP can usually help you register a domain name for you too, and link
that domain to your space on their server. A domain name is the Internet title
for your business. Today, most domains end in .com, registered with an orga-
nization called InterNIC in Washington, D.C., but many of the most useful
names with the .com ending have already been taken.

Soon there may be several different domain registration organizations, and
you should be able to get domains ending in .store and other terms—but for
now, either your ISP or you will have to contact InterNIC and pay an annual
fee ($100 U.S. to start, $50 thereafter) to get a .com, .org, or other such do-
main. If you live outside the United States, your country has a central regis-
trar for its own domains, such as .ca for Canada, .uk for Britain, and .au for
Australia, if you prefer a domain specific to your home country.
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Although an appropriate domain name can be useful, it is not essential. With
your own domain, your Web address can be short and related to your com-
pany name (such as www.mycompanyname.com), and you can have E-mail at the
same location (such as me@mycompanyname.com). That makes your Web and E-
mail addresses easier to find and remember. Still, even if you don’t register
your own domain (or prefer to wait until new options become available), you’ll
often have a fairly simple Web address (like biznet.maximizer.com/mycompany)
which you can publicize effectively.

You can ask your ISP for specifics about their Web hosting and domain
registration services. Regardless of their policies, however, the actual design
and creation of your Web pages remains up to you, and until now, that has
meant learning how to use a Web site design program, coding your pages in
HTML yourself, or paying someone to design your site for you—sometimes an
expensive proposition.

Putting up a Web site – the Maximizer way
Luckily, you can take advantage of the new Web site creation Wizard included
with Maximizer, as well as the free Maximizer Web hosting service at the
Maximizer BusinessNet, to create and launch your Web site without learning
any HTML or purchasing a Web site design application. (Find out more in
Part III of this guide.)

Different faces for different companies
The content of E-Commerce Web sites varies considerably. When thinking
about the design of your site, look around the Web for sites that intrigue you.
Examine your competitors’ and potential competitors’ sites, and see how you
can distinguish yourself from them.

E-Commerce sites range from basic to complicated, using different technolo-
gies appropriate to the sizes, types, and online experience of the businesses
they represent. Some examples include:

Come say hello – a simple Web page
The most basic E-Commerce Web site is a single page. It can be very simple:
your corporate logo, with address and phone number information and a basic
description of what you do. There can be a single link to your E-mail address
for more information or to buy. Even if you know nothing about HTML, you
can use a Web page design program such as Claris Home Page, Adobe
PageMill, Symantec Visual Page, or Microsoft FrontPage to create a
page like this in a few minutes. If you spend a short time learning HTML,
you can create the same thing just as quickly in a text editor like the Win-
dows NotePad, or a dedicated HTML editor such as Allaire HomeSite.

Before the latest version of Maximizer was released, simple contact pages
were the best way to get started on the Web because they were easy to create,
but they don’t provide much information to your visitors, and you could spend
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a lot of time answering basic E-mail questions about what you do. And when
they can’t find out specifics about your products and services on your site,
some visitors might leave without even contacting you. So if you can put
more information on your site and make it easier for people to inquire and
order, you’ll probably attract more business.

Here’s what we have – putting a catalog online
Maximizer’s Web site creation Wizard, called MARKETbuilder, takes you to
the next stage. With it, you can create a multi-page Web site with graphics,
a profile of your business, and a catalog of your products and services.
Visitors to this kind of site can
contact you using an online form,
in which they enter their contact
information and either make an
inquiry or place an order. Their
information and request is sent
to you in compressed, encoded
form by E-mail, and when you
receive it you can have the
customer data and order/inquiry
information automatically im-
ported into your Maximizer
Address Book by just double-
clicking the E-mail attachment.

Previously, this sophisticated
kind of online catalog, order
form, and request processing
system would have taken consid-
erable time, effort, and expense
to set up. With Maximizer’s new
tools, however, Web site creation is a simple matter of following the Wizard
and sending the resulting site either to the free Maximizer BusinessNet
Web hosting service, or to your own ISP’s Web server. (See Part III of this
guide, the Maximizer MARKETbuilder online help, and the Maximizer User’s
Guide for more information.)

Browse the aisles – shopping baskets and SSL security
As your business grows, your customers might expect more from your E-
Commerce site. They might want a full-fledged online store, where they can
browse, select, and check out with a number of items without having to
contact anyone personally. Many of the largest and most elaborate E-Com-
merce sites—such as Amazon books, CDnow music, Dell and Apple com-
puters, and so on—use a system that works like a shopping basket.

With an online shopping basket, customers can look at different items, add
them to their baskets, and make modifications to their total order before

A sample Web site product catalog on Maximizer BusinessNet.

http://biznet.maximizer.com
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submitting credit card informa-
tion, which is authorized before
they check out. Usually such
sites also use SSL (secure socket
layer) encryption to make sure
that customers’ credit card
information is safe, and only
available to the appropriate
server (see the “Security” section
below for more information). One
site that uses a secure shopping
basket system is the Maximizer
online store, where you can buy
Maximizer software and other
products.

Currently, setting up a shopping
basket site still requires a lot of
custom programming and design
work. At Multiactive Software,
for instance, members of our
Information Services team spent
weeks designing, programming,

and testing our online store before it went online in late 1997. They are
constantly changing it to add and remove products, respond to customer
suggestions, make it easier and more useful, and tie it in more effectively
with our accounting, user registration, and inventory systems.

A full-fledged online store like Maximizer’s requires a substantial investment
of time, effort, and skill. By the time you are ready to set one up for your
business, you should be well aware of how E-Commerce fits into your busi-
ness plan and be prepared to put some money and expertise into making it
work properly.

Welcome to the high end – everything tied together
At the high end, E-Commerce sites combine an online store with intricate
connections to other information systems. Businesses become more efficient
both because they take orders automatically and because those orders are
processed automatically too. They might use databases to confirm customers’
identities and customize pages for what individual visitors prefer, or provide
discounts for different types of clients. They can integrate online purchasing
with accounting, inventory, and even manufacturing and shipping. For
example, a buyer can make a custom order for a computer system online,
which is then built to the appropriate specifications and sent by courier.

High-end E-Commerce sites can become so-called extranets, where busi-
nesses deal with their suppliers and other businesses through the same Web

Maximizer’s online store uses a secure shopping cart system.

http://www.maximizer.com/purchase
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channels as they do with
their customers. Then, when
a visitor orders a computer,
for instance, the order can
flow through various data-
bases and information
systems to make sure not
only that the computer is
built and shipped, but that
the correct motherboard,
hard drive, memory, case,
and monitor to build it are
available first—and if not,
that they are ordered from
the appropriate suppliers.

Needless to say, that kind of
power demands a lot of
money, competence, and
cooperation between busi-
nesses. If you wish, you can
make such a system your goal for a year or more in the future (at least). If, on
the other hand, you’re ready to launch a high-end extranet today, you cer-
tainly don’t need this guide!

Simplicity and the changing face
Over time, your Web page could become a flexible, dynamic, and complex
high-end site consisting of thousands of pages, tailored for each visitor by
sophisticated custom software. But it doesn’t have to start that way. The key
to a successful E-Commerce site is not complexity, but simplicity.

Your site, however straightforward or complex at the “back end,” where the
information processing takes place, should be easy to understand and use at
the “front end,” where your visitors see it in their Web browser windows. You
can discover what researchers have found out about Web useability principles
at such sites as Jakob Nielsen’s Alertbox and User Interface Engineer-
ing. You should also visit a few E-Commerce sites like those listed in the
Appendix of this guide. Which ones do you like? Which ones are easy? Which
ones would you come back to? Why?

E-Commerce Web sites can be basic or powerful, small or large. Since they
are electronic, they can change at any time—and they should change, often. If
you’ve spent some time on the World Wide Web, you’ve probably seen “under
construction” signs on Web sites. I think those signs are nearly useless,
because a good Web site should always be under construction, changing to
stay interesting, to reflect feedback from its users, and to highlight new
things. Don’t change how your site looks or works just for the sake of change,

The Canadian version of Dell’s online build-to-order (BTO)
custom computer store, on the Web at www.dell.ca.

http://www.dell.ca
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though. Your visitors get used to a certain way of doing things, so while
they’ll appreciate a new special each week, for example, they won’t like it if
they have to re-learn how to find the special every week too.

What keeps people coming back to your site, then, is a combination of factors,
including your products and services and their prices; your marketing savvy;
how easy your site is to find, understand, and use; how the site and your
service make them feel about your business; and how often the site changes
to keep them interested.

Security: hackers and snoops
and encryption, oh my!

Many writers and analysts, both on the Web and in the more tradi-
tional media, think that security concerns might prevent Internet E-
Commerce from succeeding, but E-Commerce is already more secure
than most traditional business transactions. The problem lies in the percep-
tion of security problems on the Internet.

Traditional security
When you phone or fax in a credit card order to a traditional mail-order
business, nothing in particular guarantees the security of your information.
The fax machine at the other end could be in an open office where anyone
could grab your transmission and use the numbers. The operator could write
your credit card data on a slip of paper that could be taken the same way.
When you give your card to your server in a restaurant, you can’t be sure
what happens to the information while it’s out of your sight.

Yet people perceive these kinds of transactions as safe because they’ve been
around for years, and in that time we’ve discovered that most people don’t get
ripped off. We trust that nothing untoward will be done with our sensitive
credit card numbers. With good reason, too: any business that regularly let
its customers’ credit cards be defrauded wouldn’t have those customers for
long.

E-mail security
The truth is that even having your customers send credit card information by
E-mail as plain text, without any encoding at all, is more secure than most
traditional credit card transactions. Although it’s possible for someone to
intercept the credit card numbers as they get routed through the Internet to
their destination, it is more difficult than snooping on cellular telephone
calls, for instance.

If you have customers separate their credit card numbers into two individual
E-mail messages, one half in each, snooping is even harder, since the Internet
is designed in such a way that two E-mails are likely to reach their target by
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entirely different routes—and anyone trying to intercept them wouldn’t be
able to get both parts. Maximizer’s online inquiry processing system for your
E-Commerce Web site goes even further by encoding and compressing cus-
tomers’ data before it is sent to you as an E-mail attachment.

Web security
A few years ago, Web browser makers realized that if commerce were ever to
become serious business on the Internet, they would have to address security
concerns as well. The major browsers, Netscape Navigator and Microsoft
Internet Explorer, have included secure socket layer (SSL) technology since
their 3.0 versions, and many other browsers such as Opera do as well.

The SSL technology implemented in many “shopping cart” style sites uses an
electronic identity certificate, for which E-Commerce merchants like you
apply through a certificate service called VeriSign. The certificate acts as a
“signature” to verify that a secure Web server is from the
company it claims to be. Customers’ names, addresses, and
credit card numbers are processed by complex mathemati-
cal encryption algorithms to ensure that only the autho-
rized server to which they are connected can decode the
information. You can tell when you are making a secure
Web transaction by the Web address, which is preceded by
https:// instead of just http://, and by the appearance of a
solid key or closed padlock icon in the lower corner of your
browser window.

The “strong encryption” versions of the major Web browsers are so secure, in
fact, that the United States government classifies their encryption technology
as a munition, like guns and explosives, and restricts the strong-encryption
browsers from being exported outside the U.S.A. and Canada. (The regular-
encryption browsers available elsewhere in the world are extremely secure
too—just not secure enough to be considered a weapon!)

Let your customers know
Internet security is, therefore, not such a big deal. Once you’ve addressed
basic security concerns using E-mail splitting, Maximizer’s encoded attach-
ments, or more advanced technology like SSL, you should put a little effort
into telling your customers about your work, explaining that they should be
cautious on the Internet, but only as cautious as they are in any other pur-
chasing environment. Reassure them on your site that they generally have
little to worry about.

Secure

Insecure
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Stay structured, plan to grow
Now you understand some of the fundamentals of getting your busi-
ness online. Since the Internet and the Web change so quickly, the
most important thing to do when you make up your E-Commerce
blueprint is to plan for change, and for growth.

As with any other aspect of business, having a consistent, structured
approach to E-Commerce can help you evaluate where you are and prepare
for change at any stage. Keeping track of visitors to your site, online inquir-
ies, orders, sales, and follow-ups with customers helps your business thrive.
Fortunately, Maximizer not only lets you build and post your own E-Com-
merce Web site, it is also one of the most established, renowned, and powerful
customer and contact managers around. Using it to track your contacts and
business activities keeps you on top of what you need to do at all times, and
gives you a running history of everything you’ve done.

As E-Commerce progresses in the next few years, Maximizer will keep up too,
so that you can adapt your site to the current trends and technologies. Right
now, Maximizer offers you the easiest way to get your site up and running,
then manage your online prospects and customers. The next part of this
guide explains how.



24 – Doing Business Online with Maximizer



Doing Business Online with Maximizer – 25

Part III: Maximizer
and E-Commerce

NOW YOU KNOW some of the history of E-Commerce on the Internet, its current
state, and what to expect in the immediate future. All you have to do is get
your business online. Maximizer is here to help.

The latest version of Maximizer
features a new “Web” menu. To make
Maximizer’s all-new Internet elec-
tronic commerce features easy to find,
the Web menu includes its own “E-
Commerce” sub-menu, which contains
five simple commands to get your E-
Commerce effort rolling. They appear
in the order in which you’re most
likely to use them, and they’re de-
signed to prevent you from missing
the five key steps of setting up a
successful E-business.

I’ll cover the first two, building and marketing your site, in the greatest
detail. You can find more information about the rest—handling your E-mail,
taking orders, and managing your customer information—in the Maximizer
User’s Guide and the Maximizer online help.

1. Build your site: the MARKETbuilder Wizard
As I mentioned in the previous section, until now you have had three options
for building a Web site: buying a Web page design program, learning to code
in hypertext markup language (HTML) to create pages from scratch, or
paying someone to make your pages for you.

With Maximizer, however, there is finally a new way. The MARKETbuilder
Wizard (choose Web>E-Commerce>MARKETbuilder Web Site Creation Wizard in Maxi-
mizer) takes you through the creation of a your site in a simple ten-step
process. It gives you the option of dozens of different site design templates
and color schemes. You enter your own profile, product and service data, and
contact information. You can include your own graphics. On the last screen of
the Wizard, you can either send the completed site to the free Maximizer
BusinessNet Web hosting service (see “Hosting and Promotion” below) or to

Maximizer’s new Web menu includes ways to search for
information about Address Book entries, plan travel routes,
search the Internet, and visit Web sites, as well as build and

manage your own online E-Commerce site.



26 – Doing Business Online with Maximizer

In your browser, View>Page Source tells you a lot about a Web page, including
title, description, and META information. It also often tells you what software

was used to build the page—and maybe even who the person who did that was.

your own Internet service provider. You can make changes to your site using
the same Wizard, whenever you need to, 24 hours a day.

You do not need to know any HTML or be a graphic designer to create a good-
looking site using MARKETbuilder. The Web site creation
Wizard is easy to use, and there are details about its
features in the Maximizer User’s Guide and in the
MARKETbuilder online help, which you can find anytime
you’re running the Wizard by pressing the F1 key on your
keyboard or by using the “Help” menu. Rather than

explaining each feature in detail, then, I’ll discuss how the Wizard makes
sure your site is complete.

Contact information
The MARKETbuilder Wizard won’t let you post a site without proper contact
information. That’s to your benefit: just because a customer finds you on the
Web doesn’t mean he or she wants to be in contact with you only there.
Providing a mailing address, phone and fax numbers, and an E-mail address
means people can reach you however they prefer. Customers are also far
more likely to trust a business that they can see exists in the real world, not
just in some vague part of cyberspace.

If you already have another Web site, if you plan to in the future, or if you are
affiliated with another organization or person with their own site, you can
link to it from your Maximizer site by entering the other site’s Web address in
the appropriate MARKETbuilder field. Make sure the other site links back.
This kind of cross-linking is a free and effective way to bring people to your
site, as I discuss in “Hosting and Promotion” below.

Keywords for search engines
You can choose a title for your Web site, as well as a short description and
several keywords about it. When people visit your site, the title appears in
the title bar
at the top of
their Web
browser
windows.
The key-
words don’t
appear on
screen, but are
hidden in so-called
META tags—be-
cause they are meta-
information, describ-
ing the pages on
your site rather than
being part of them—

http://www.maximizer.com
http://www.maximizer.com
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inside the HTML of your home page. (You can see META tags if you look at
the HTML code of almost any Web site home page you visit. Choose View>Page
Source—sometimes it’s Frame Source or just Source—from your Web browser’s
menu bar.)

The title and keywords are important. When people use Internet search
engines, such as AltaVista, HotBot, Infoseek, Lycos, Webcrawler, and
Excite, to look for businesses like yours, the words you use here are most
likely to be the ones the search engines find. Note that Yahoo!, perhaps the
best known Internet search site, is not a search engine at all, but an Internet
directory. Read more about the difference and how you should promote your
site to directories like Yahoo! in “Hosting and Promotion” below.

Search engines are automated tools, programmed to “crawl” or “spider” across
the Web, indexing the text on Web sites as they go (graphics are not indexed,
except for any HTML text that describes them), and trying to organize it so
when users enter search terms, the returned results are relevant. Conse-
quently, some search engines turn as much as 50% of their attention to the
title of your site alone. After all, it’s reasonable to assume that a Web site’s
title should indicate pretty well what the site is about.

So when you title your site, include not just the name of your business, but
some words people are likely to search for to find you. For example, in the
spring of 1998, the title bar on the Maximizer home page (see the picture
above) included the phrase “contact management software.” We added that
phrase both to help Web users find Maximizer when looking for contact
managers, and to distinguish the Maximizer site from other sites with the
word “maximizer” in them, but which are not about contact management
software—and there are a few. Choose your title wisely.

Add a few other important words or phrases as keywords. Search engines will
note them and they will help searchers find you. Your short description will
help too, because it will influence your site’s search rankings, and will also be
what people see as a summary if your site shows up in their search results.
An informative description can entice people to your site from a long list of
Web addresses returned by a search engine.

Search engines are one source of visitors to your site, but it’s impossible to
ensure that you show up high on the list of results for every possible relevant
phrase. Even companies who specialize in getting sites to show up high in
search engine rankings often aren’t especially easy to find using those same
search engines! Search engines are not necessarily the most important way to
get Web site hits anyway. (See “Hosting and Promotion” below for others over
which you have more control.) Pick a good title, description, and keywords to
appease the fickle search engine gods, then move on to designing your site.

Products and services
The more information you have online, the better for your customers, and for
you. As long as it’s not all presented in one huge, overwhelming page—in
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other words, if visitors have the choice to find out
more, as they will with your Maximizer site—they
can learn as much as they like (or as much as you
want to let them) about your business without
needing to contact you.

That way, you can show how your products and
services stand out from the competition’s, and avoid
answering some of the most basic questions over
and over again. People who would rather not blindly
E-mail or telephone you can inform themselves.
You’ll have more time to tend to your business.

Maximizer’s Web site Wizard lets you make individual Web pages for each of
the products or services you offer, with pricing and ordering information, in
its Catalog section. If you sell many items or provide many services, you can
use these pages as categories for them instead. Each one includes a descrip-
tion, and can have an associated picture, logo, or illustration.

The right words, well written
If you think of your Web site as the face of your business, then you don’t want
a face framed by unkempt, dirty hair, with food between your teeth and a
crust of toothpaste on your upper lip. That would be unprofessional.

Similarly, nothing makes a site look unprofessional more than sloppiness,
and one of the sloppiest things on many Web sites is the writing. Misspelled
words, typos, and incorrect grammar imply that you are not a careful
businessperson. Visitors are less likely to trust you and might leave your site
if your writing is not carefully proofread and edited. They might not even be
sure why they don’t like the site, since they might not spot spelling and
grammar mistakes, but simply find the writing awkward and hard to under-
stand.

So when you type the entries for your catalog or list of services—as well as
anything else you write for your site—proper spelling and grammar are
critical. It’s probably best to write content for your site in a word processor
(the Maximizer Word Processor, for instance) and use the spell checker
rigorously, then copy and paste the text into the MARKETbuilder Wizard.
Read it yourself too, since spell checkers will completely miss words that,
despite being correctly spelled, are still errors because they are in the wrong
place.

Have someone else who is good with words look your site over, either when
you preview it in the Wizard, or after you have put it online but before you
have promoted it to anyone. Even if you are an excellent writer, a fresh set of
eyes will catch many errors that you miss. If you feel uncomfortable writing,
ask a skilled friend, associate, or relative to help—or you can hire someone to
write for you if you prefer. You can’t afford to have a badly written site.

The MARKETbuilder Wizard lets you build
your own online catalog–style Web site.
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Graphics
Graphics are what made the World Wide Web popular. For years, the Internet
was a text-only place, and although plain text is a great way to share infor-
mation, it is difficult to make eye-catching. It’s also hard to pack as much
information into a page of words as into one picture.

Unfortunately, creating graphics for the Web is a complicated endeavor, and
still an immature art. A number of large books have been written on the
subject. If you would like to learn the nitty-gritty details of working with
browser-safe color palettes, optimized GIF animations, JPEG compression
artifacts, transparency masks, the PNG file format and its 8-bit transparency
masks, and LOWSRC code tags, try a book such as Designing Web Graphics
(2nd Edition, New Riders Publishing) by Lynda Weinman.

If you’d rather avoid all that stuff, you’re in luck. The MARKETbuilder
Wizard can read a number of different graphic file formats, and it converts
them to the correct file type and size for display on your Web pages. But
because it does so automatically, without knowing what your images actually
represent, it may not do a perfect job. Even if all you’re doing is scanning and
manipulating your company logos, you can help your online presentation by
doing three things when preparing photographs, logos, and illustrations for
the Web:

1. Save them as GIF (Graphics Interchange Format—for logos, cartoons, and
illustrations) or JPEG (Joint Photographic Experts Group—for photographs and
detailed artwork) files. Graphics programs such as Paint Shop Pro, Adobe
Photoshop, Corel Photo-Paint, and others let you select these file types when
you save graphics. When using JPEG for photographs and art, go for the highest
compression possible that still leaves your image looking good. Save at 72 dots
per inch (dpi) if you have a choice.

2. Keep the file size small, so visitors with slow modems (that means most visitors
these days) won’t have to wait too long to see your pages. Smaller images load
faster. Buttons should be no larger than 5K, and preferably more like 2K. Larger
illustrations and photos can be bigger, but no single image should be over 30K,
and a 20K limit is better. In fact, some designers limit the size of all the text and
images on a Web page to 30K in total. You can reduce a graphic’s file size by
making the image dimensions smaller, using transparency, turning off interlac-
ing (the option which makes an image “come into focus” as it loads instead of
“painting” from top to bottom), reducing the number of colors—or even making it
black and white.

3. Make your graphics fit the MARKETbuilder templates. Post or preview your site
with test graphics and see how they fit into the design. Then create new graphics
or resize your old ones to fit the spaces in the template design you’ve chosen. The
Wizard will automatically resize graphics that don’t fit, but if you make yours
the right size and shape to start with, your site design will work better and it
won’t contain images that are any larger than necessary.
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The Web itself is a great source for graphics. There are many free clip art
sites, such as the Xoom Web Clip Empire, where you can download graph-
ics already prepared for the Web in GIF and JPEG formats. Remember,
though, that your graphics are one of the main ways to distinguish yourself
from the competition—don’t use commonly-seen clip art for everything.

It wouldn’t hurt to learn a bit more about Web graphics and design in gen-
eral, however, especially the browser-safe colors. If you’re interested and
would like to take the time, use some of the resources in this guide’s Appen-
dix to help you make your graphics look and work better on the Web. You can
also, of course, hire someone to create graphics for you, and if they already
know something about Web graphic design, so much the better.

Taking credit
Any business with a bank account can accept cash, checks, and money orders.
You can choose to limit yourself to that with your Maximizer site as well.
However, if you set up a credit card merchant account with your financial
institution, you can also use the MARKETbuilder
wizard to accept credit cards online. The Wizard lets
you choose which ones you recognize—major cards
are already pre-programmed in, and you can add
any others you wish.

The Maximizer BusinessNet provides a section of
the order form on your site where purchasers can
enter their credit card information. That information
is then sent to you by E-mail as an encrypted,
compressed, and encoded attachment which is quite
difficult to intercept and decode. Once you have
decoded it in Maximizer, you then process the transaction manually as you
normally would.

As in mail order shopping, credit cards benefit both you as a merchant and
your customers. Neither of you has to wait for a money order to arrive or a
check to clear before processing a transaction. Once a card payment has been
authorized, you are each assured that the other person is reputable—you
know the customer has good credit, and they know your business is suffi-
ciently stable to have a merchant credit account. And if you sell a digital
product, such as software, or a service, such as proofreading, you can E-mail
the purchase to the customer or contact them to begin the service the same
day.

Consistent design
A haphazard design is, unfortunately, all too easy to create (even unintention-
ally) using many traditional Web site design applications, and especially
using raw HTML code, particularly as you make changes to parts of a site
while leaving others alone. Over time, even a well-designed, consistent site

Accept different credit cards on your
Maximizer E-Commerce Web site.
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can drift into groups of still-similar, but naggingly inconsistent pages.

One of the biggest advantages of Maximizer’s MARKETbuilder Web site
creation Wizard is how easy it is to fit your information into a consistent

design. Since the Wizard uses a series of templates
for your site, to which you can apply any one of a
large number of color schemes, there is a lot of
variety to how your site can look. But once you
choose a template and scheme, that design applies
to your whole site.

Therefore, when your site is finished and ready for
uploading to a Web server, every page, though
different, shares design elements and colors.
Together, they make a coherent Web presence, not
just a semi-random assembly of pages. Any time

Keep your site design consistent using
pre-made templates and color schemes.

you make changes—even if you choose a totally new template set and color
palette—the entire site keeps the look, and looks professional.

You just have one more step to get your business online. Look out though: it’s
a big one.

2. Host and promote: Maximizer BusinessNet
The moment has arrived. You’ve decided to take your business into
E-Commerce. You’ve made graphics, optimized them for the Web,
and created text for your site. You have used the MARKETbuilder
Wizard to assemble your elements into Web pages, and you’ve
chosen a design and color scheme. Now you’re ready to take your site
live, to put it on the Internet.

This is not where the work ends. It is, in fact, where some of your most
important work begins. The world’s most beautiful, well-written, and easy to
use site is no good if no one knows about it. Once again, though, Maximizer
gives you a helping hand.

Hosting your site: have it your way
You have two simple alternatives for connecting your site to the Internet: you
can use Maximizer’s free hosting service at the Maximizer BusinessNet
(choose Web>E-Commerce>Visit BusinessNet in Maximizer), or you can use
Internet-standard file transfer protocol (FTP) to upload to any other Web
hosting service you already have (such as space on your ISP’s Web server) or
would like to use (such as if you plan to have your own personal or company
Web server). Either option is as easy as the click of a button on the last
screen of the Wizard.

Note, however, that the Maximizer BusinessNet has several advantages.
First, it’s free—something neither your ISP account nor any server you own is
likely to be. Second, on the BusinessNet your site is automatically promoted
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to the major search engines (see “Promoting Your Site” below). Third, your
BusinessNet site is part of a community of sites that people can search from
the main Maximizer BusinessNet home page. Fi-
nally, since Maximizer, the MARKETbuilder Wizard,
and the BusinessNet are all designed and tested to
work together seamlessly, the whole process of
building and maintaining your site will run more
smoothly.

Regardless of whether you host your site on the
Maximizer BusinessNet or somewhere else, the
inquiry and order forms always run from the
BusinessNet server, since they use special Maxi-
mizer-customized server software. Happily, that
software is designed so the connection between your Web pages (wherever
they are) and the BusinessNet-hosted forms is always automatically ready in
the background—you don’t need to worry about it, and neither do your visi-
tors.

Promoting your site online: the never-ending quest
As in all other types of business, marketing and promotion are key to success
in E-Commerce. Over 1000 new Web sites appear on the Internet every day,
so without promotion any site is effectively invisible. I’ll discuss the basics of
site promotion here, but there are many other resources online, such as the
Ward Group’s NetPOST site, where you can find more detailed advice. I’ll
also try to steer you clear of some methods of online promotion which receive
a lot of hype, but may not work so well for you.

One universal (and reasonable) rule of Web promotion is that it is better to
put your effort into specialized areas related to your field of business than to
try to spread the word to everyone on the Net. As I said in “More Users Mean
More Diversity” in the first part of this guide, the Web is stratifying, and it’s
no longer possible to reach everyone, just as hundreds of cable and satellite
television channels have divided the TV viewing audience advertisers can
reach.

If you host your E-Commerce site on the Maximizer BusinessNet, you can
sign in at biznet.maximizer.com and obtain statistics about people who visit
your site. You can use this information to determine how successful your
marketing effort is. If you host your site elsewhere, your ISP or server admin-
istrator should be able to provide you with similar statistics, although they
may charge a fee depending on how detailed you want the stats to be.

Search engine submissions – automatic and manual
The Maximizer BusinessNet takes the first step to promoting your Web site
for you, by automatically submitting the URL of your Web site, which will be
in the form biznet.maximizer.com/yourcompany, to the major Internet search

Upload your site to the BusinessNet, or
by FTP to your own Internet provider.
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engines—with your title and the META description and keywords you en-
tered in the Wizard. (You can, by the way, access these search engines from
Maximizer’s Web menu to look for information about entries in your Maxi-
mizer Address Book—choose Web>Search.) If you don’t host your site on the
Maximizer BusinessNet, but on another server, such as your ISP’s, you will
have to submit its URL to the search engines yourself. See the Appendix for
more information.

Many Internet users search first at Yahoo!, one of the Internet’s oldest and
best-known search pages. It is a directory of Web sites, not an automated
search engine, so instead of indexing all the text on every site possible,
Yahoo!’s staff put sites into catego-
ries based only on information
those sites’ administrators submit
to them. You should therefore visit
Yahoo! and submit your site’s
information to it manually. In-
structions for doing that are
available at the Yahoo! submis-
sion URL listed in the Appendix
of this guide.

A more useful aspect of Yahoo! is
as a good place for you to look for
alternative ways to promote your
site. Yahoo!’s Directory List is a
good source of information about
other directories to which you can
submit, such as The Mining
Company, Magellan, and
LookSmart. There are hundreds
of other search engines out there
too, and Yahoo! has links to most
of them in its Search Engine
List category.

Many smaller search engines and
directories will not be of much use to you, but you might find specialized ones
that target an audience you seek. For instance, if you sell medical supplies,
you can submit your site’s information to a search engine or directory de-
signed for physicians and other medical personnel.

As I mentioned in the “Keywords” section above, search engines and directo-
ries are useful, but they’re only one way to get people to your site. There are
many others over which you have more control. The best methods take some
detective work and promotion effort, but unlike the major search engines,
they are targeted to people who have specific interests related to your busi-
ness. Even though they reach fewer people overall, the people they do reach
are more likely to respond and visit your site. Some common Web marketing

You can access some of the major search sites from within
Maximizer using the Web>Search command.
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concepts, on the other hand, might seem like sure things, but they’re often
more complicated than they appear.

Spam is gross, and bad for your Net health
One of the beauties of the Internet is that you don’t have to pay to put the
word out on it. Aside from the search engines, E-zines, cross-linking, and
mailing lists I talk about below, there are free Usenet newsgroups where
people discuss almost any topic you can imagine (undoubtedly including
topics related to what you’re selling), as well as the general sea of people who
just read their E-mail. You can theoretically get your message out to millions
of these people free or very cheaply.

A common mistake of first-time online marketers, therefore, is to post promo-
tional messages to any online place possible, regardless of relevance or
whether anyone asked for them. After all, there seem to be a lot of people
online providing lists of millions of E-mail addresses, and there are thou-
sands of Usenet newsgroups. Sending E-mail and posting Usenet messages is
free. So what do you have to lose by just taking a shotgun approach and
marketing to everyone, hoping that even a tiny portion of the online millions
will come to your site?

You stand to lose a lot. Such unsolicited commercial E-mail and Usenet
postings are known online as “spam” (after the Monty Python sketch in which
a restaurant’s menu consists of almost nothing but “spam, spam, spam, spam,
spam, and spam”). Like junk faxes and postal mail, they annoy people a lot.
And because spam is free to send, it is becoming a real problem on the
Internet.

Users who have been online a long time—like me—often receive dozens or
even hundreds of spam E-mails every week, and they interfere with trying to
get any real work done. Some Usenet groups have died as useful places of
conversation because they are choked with dozens of unrelated spam mes-
sages. Servers have even crashed because huge amounts of spam E-mail have
overloaded them.

There are serious moves afoot to make spam illegal. In some places, such as
Washington State, it already is, and you can be fined for sending it. Even
where it is not yet illegal, people who send spam find themselves the targets
of thousands of angry E-mails from the recipients. There’s a good case to be
made that if you try to promote your business with spam, you might lose
business instead of gaining it. You’ll certainly lose time reading (or even just
deleting) all the abuse you get from angry spam recipients. Besides,
spamming is rude. It makes your business look amateurish. Don’t try it.

Getting announced
Since sending spam is out of the question, you might be tempted to try to get
your site onto one of the popular “what’s new” and “cool site of the day” (or
week, or month, or even minute) pages on the Web, such as the well-known
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Netscape What’s New or Project Cool. I say
try, because since these sites are so popular (they
get hundreds of thousands or millions of visitors a
day), and can get astounding results (they might
bring 25,000 people to your site in one day if
you’re listed), it is ridiculously difficult to appear
on them. They rarely profile new business sites
unless there is something extremely unusual an
interesting about those sites—and despite what
you may think, your first E-Commerce pages are
unlikely to fascinate everyone.

More viable are “what’s new” sites specific to the
industry you’re targeting. Once again, look at
Yahoo!’s Announcement Site List for options.
Similarly, you can check the online ZineRack
and the E-Zine List sites for listings of electronic

magazines (E-zines), and the various listings of Internet E-mail mailing lists
(such as PAML, The Liszt, and of course Yahoo!’s Newsletter List) related
to your business where you might be able to get a mention or even place an
advertisement.

Buying advertising
Web advertising is still a young industry, and still shows signs of its immatu-
rity. Large-scale online advertising (such as graphic ads on the Yahoo! home
page) is extraordinarily expensive, costing tens or hundreds of thousands of
dollars, and the response rate is typically lower than for similarly priced TV
advertising. Therefore, as in television, only large companies with large
marketing budgets can afford it—you’re unlikely to.

On the other hand, smaller-profile ads, such as sponsorships of relevant
mailing lists, small news sites for your industry, or other grassroots online
communities, can be extremely cheap and cost effective. Many mailing lists,
for example, are run by passionate volunteers, who use sponsorship as a way
to pay their expenses. A mailing list directly related to your industry, with a
few thousand subscribers, might accept your sponsorship for a few hundred
dollars per month, maybe even less. You’ll get a listing in each issue, and if
you pick the right list, you’ll reach people who want to know about your
products and services.

Even better, the subscribers will feel good about your business because you’re
sponsoring a mailing list they like. If you’re lucky, you might even get more
visitors (and sales) than you would with a general banner ad that costs a
hundred times as much as your sponsorship.

Usenet and mailing lists
The online Usenet newsgroups (accessible with the newsgroup-reading
features of your Web browser or with dedicated software) can be a good place

Try www.zinerack.com for a large list
of online Web magazines.

http://www.zinerack.com
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to promote your business, but although newsgroups and mailing lists are
free, you must be extremely careful. Some groups accept commercial postings,
some don’t. Some have arcane rules about what you can and can’t say in a
commercial posting, and sometimes those rules are unwritten. If you breach
the etiquette of a particular group, you risk getting lots of flame mail.

So the best way to go about promoting yourself on newsgroups (and mailing
lists too, in fact) is to join the discussion on relevant ones. If a group is closely
enough related to your business, you might very well have something produc-
tive to say. Start by reading the posts for a few days or weeks and trying to
understand how the particular group or list functions. Then join in the
discussion. Your promotion might be limited to a tag line in your signature at
the end of each message or, if appropriate, you might post an announcement
when your business does something the group’s readers might like to know—
but make the post short.

Think of newsgroups and E-mail lists as clubs. You need to join and partici-
pate to add some value before the members will accept a pitch from you.

Cross-linking
One of the cheapest ways to promote your site is to use a search engine,
directory, or word of mouth to find other good sites related to your field of
business, then to cross-link to them—you provide a link to them from your
site, and they link back. You contact whoever runs the other site, perhaps by
phone or E-mail, and make the appropriate arrangement. You pool your
mutually interested users and build a customer base.

You’ll want to avoid putting too many cross-links at your site, however,
because your visitors might be tempted to leave your site altogether for
another one they find more interesting. At first, you might just want to find
one other site that complements yours well, or one relevant directory or list of
links to which you can make a single link on one of your Web pages.

Hiring someone
In addition to the Maximizer BusinessNet’s built-in search engine promotion,
there are services that will submit your site to dozens or hundreds of search
engines for a small fee, and you usually get what you pay for—that is, not
much. It’s much better to target specific specialized search engines yourself,
as I mentioned in the previous section. If, however, you insist on hiring
someone to help with site promotion, find someone reputable or at least
genuinely knowledgeable, preferably with a successful track record and
references from other sites, who will do a serious, good job of marketing your
Web site in a variety of ways. You’ll likely spend quite a bit more, but at least
the expenditure is more likely to pay off.

Keep looking
There are always new online ways to market yourself. Keep an eye open, and
budget a small portion of your time to exploring the Net to find places your



Doing Business Online with Maximizer – 37

business might fit. It can be fun, or it might be tedious, but the quest for your
online marketing niche never ends.

Promoting your site off-line: don’t forget about it
Don’t treat your E-Commerce site as a separate entity from the rest of your
business marketing plan. Whenever you do anything promotional, from
creating business cards and flyers to sending out news releases and buying
newspaper ads, include your Web site URL and E-mail address. If there are
trade publications in your field, promote your online presence in them along
with the rest of your business. And highlight your new ability to sell online—
people reading about you in print, meeting you at a trade show, or hearing
about you on the radio might be interested in looking at what you have to
offer if they don’t need to leave their homes to do it.

As I said in “E-mail is a Killer” in the first section of this guide, your Internet
information should appear everywhere your phone number and address do.
Some companies take it even further than that—there are now billboards and
business cards that contain nothing but a company’s URL. Don’t forget,
though, that there are still a lot of people who are not online, and depending
on your field, they may still be the majority of your potential customers.
Balance your online and off-line marketing accordingly.

3. Correspond with customers: the E-mail Center
The Maximizer development team greatly enhanced the program’s
E-mail features in this latest version. Now you can deal with all of
your E-mail and never leave the Maximizer workspace. The Maxi-
mizer E-mail Center includes features found in no other program,
and several of them can help your online business succeed.

If the current database of suppliers, customers, and other contacts in your
Maximizer Address Book includes their E-mail and Web addresses, you can
easily send E-mail and connect to their Web sites, each with a single click on
the Maximizer toolbar. Whenever you send E-mail to or receive it from a
client, Maximizer logs the event in your notes so you can track your electronic
correspondence. You can send mass E-mails to groups of contacts in your
Address Book, or to everyone, even more easily than regular mass postal
mailings. So it’s a good idea to enter E-mail and Web site addresses for every
entry in your Maximizer Address Book for which you can obtain that informa-
tion.

The newest features of the Maximizer E-mail Center save you a lot of time
too. When you receive an E-mail from an address already in your Address
Book, the E-mail is linked to that entry in the background by Maximizer. In
the E-mail Center window, you can see incoming, sent, and deleted mail for
the current entry in their own separate folders. If you get an E-mail from a
new person or company, just drag the E-mail to your Address Book window to
create a new entry for it automatically. And if an E-mail announces or re-
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minds you about an upcoming
event, you can drag it to your
Hotlist window to create a to-do
task.

Using Maximizer’s E-mail Center,
you can put your E-mail in order
the same way you do other informa-
tion about your customers, and in
the same program. Maximizer helps
keep your E-mail organized, and
that means you can be more effi-

cient. Together with your new E-Commerce site, Maximizer can even help you
do the actual selling.

4. Sell online: customer orders by E-mail
When potential customers visit your E-Commerce site, they can fill out an
online form to inquire about your products and services or to order something
from you. As you’ve read, the data from this form, such as name, address,
credit card numbers, and so on, gets encrypted, compressed, encoded, and
sent to you by E-mail.

When it arrives, open the E-mail in the Maximizer E-mail Center (choose
Web>E-Commerce>View Order/Inquiry E-mails). There you can double-click the
compressed attachment to automatically create a new Maximizer entry for
the customer placing the inquiry or order, using the information they entered
into the form. Subsequent E-mail correspondence with that customer will be
logged to your Maximizer notes. Respond quickly—Web users are accustomed
to fast turn-around times.

E-mails from your E-Commerce site are sent with “Maximizer Web Order” or
“Maximizer Web Inquiry” in their Subject fields. You can use the drop-down
filter box in the E-mail Center to display only E-Commerce orders, inquiries,
or both, so you can separate your online selling from other E-mails you send
and receive.

Maximizer does all of this for you with minimal intervention on your part, so
you can concentrate on taking care of your customers instead of entering
their information into your Address Book and then manually logging each E-
mail. The program even creates a Favorite List (choose View>Favorite Lists and
look for one called “Customer List”) of your E-Commerce clients.

5. Manage customers: the power of Maximizer
Once you’ve imported customer information from your E-Commerce online
forms into Maximizer, you can handle that information with all the customer
and contact management muscle the program is renowned for. Orders and

Read your E-mail, including E-Commerce orders, in Maximizer.
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inquiries are automatically logged to your Notes window, and the Web>E-
Commerce menu includes easy ways to search for those orders and inquiries at
any time.

You can use all of Maximizer’s other powerful, flexible, and fast tools on the
information that comes to you from your Web site and by E-mail, for search-
ing, sorting, viewing, organizing, and understanding your customers. When
you coordinate all of your business, online and off, using Maximizer, your
customers will be impressed by how you remember little details and get
things done speedily and with minimal fuss.

Since it was first developed in 1987, Maximizer has helped growing busi-
nesses work as though they were bigger than they really are, by saving
people from having to track information on paper lists and in their heads, so
that they can concentrate on actually running their businesses. Now that
control has been extended to the Internet too.

6. Maximize growth
Maximizer has been Internet Savvy since 1996, letting you work with E-mail,
download prospects from the Internet using List Merchant, obtain updates
and enhancements from our Web site, and more. Our corporate products such
as Maximizer Enterprise and MaxExchange harness the power of the
Internet for larger workgroups too, even letting them synchronize remote
databases over the Net. Instead of just adding Internet features onto our
products, Multiactive Software has extended our programs’ core functions to
work with the Internet. Maximizer’s new Web menu, for instance, has many
commands outside the E-Commerce sub-menu that help you search for and
use information on the Internet and bring it into Maximizer.

The current version of Maximizer is only our first step to help you in the new
E-Commerce world. As that world changes—and it will—Maximizer’s E-
Commerce features will improve too. Both in our software and via our own
online presence at the Maximizer and Multiactive Web sites in North
America and abroad, we’re committed to making the Internet part of every-
thing we do, so it can be a part of everything you do.

Good luck on your E-Commerce adventure, and thank you for bringing Maxi-
mizer along.

http://www.maximizer.com/max5
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Appendix
I refer to most of these URLs in the text, but a few appear only in this Appendix. By the way, you can often find more information from
long URLs (such as www.zdnet.com/anchordesk) by truncating them at the slashes (to www.zdnet.com, for instance). Try it.

Part I: Understanding
E-Commerce

Computer firms selling online:
Apple • store.apple.com
Adobe • www.adobe.com/purchase
Dell • www.dell.com
Gateway 2000 • www.gateway.com
Microsoft • www.microsoft.com/referral/

ShopDefault.asp

Other major online sales sites:
Amazon.com • www.amazon.com
Barnes & Noble • www.barnesandnoble.com
CDnow • www.cdnow.com
eBay Internet • www.ebay.com/aw

Internet research companies:
Computer Intelligence • www.ci.zd.com
Cyberdialogue • www.cyberdialogue.com
The Gartner Group • www.gartner.com
IntelliQuest • www.intelliquest.com
International Data Corp. • www.idc.com
+Plan • www.zdnet.com/anchordesk/

story/story_1915.html

Online commentary and analysis:
Jakob Nielsen’s Alertbox •

www.useit.com/alertbox
ZDNet Anchordesk • www.zdnet.com/

anchordesk

Sears • www.sears.com

Part II: E-Commerce
Today

See above for Apple, Amazon, CDnow,
Dell, Jakob Nielsen’s Alertbox, ZDNet
Anchordesk

See below for Maximizer BusinessNet,
Yahoo!

Online research and commentary:
GVU 8th Web Survey • www.gvu.gatech.edu/

user_surveys/survey-1997-10/graphs/use/
Indispensable.html

User Interface Engineering • www.uie.com
Wired magazine • www.wired.com/wired/

6.04/es_lists.html

E-mail services and software:
AT&T WorldNet • www.att.com/worldnet
Microsoft Outlook • www.microsoft.com/

outlook
Eudora Pro • www.eudora.com
Pobox • www.pobox.com

Web history and administration:
CERN and the Web • www.w3.org/People/

Berners-Lee/ShortHistory.html
InterNIC • www.internic.net/rs-internic.html
VeriSign • www.verisign.com
World Wide Web Consortium • www.w3c.org

Web page design software:
Adobe PageMill • www.adobe.com/

prodindex/pagemill
Allaire HomeSite • www.allaire.com/

homesite
BBEdit • web.barebones.com/products/

bbedit/bbedit.html
Claris Home Page • www.claris.com/

products/claris/clarispage
GoLive CyberStudio • www.golive.com
HoTMetaL Pro • www.softquad.com
Macromedia Dreamweaver •

www.macromedia.com/dreamweaver
Microsoft FrontPage • www.microsoft.com/

frontpage
NetObjects Fusion • www.netobjects.com
Symantec Visual Page • www.symantec.com/

domain/cafe/vispage.html

Web browsers:
Lynx • www.fdisk.com/doslynx/lynxport.htm
Microsoft Internet Explorer •

www.microsoft.com/ie
Netscape Navigator/Communicator •

home.netscape.com/download
NCSA Mosaic • www.ncsa.edu/SDG/

Software/Mosaic
Opera • www.operasoftware.com

Part III: Maximizer
and E-Commerce

Maximizer products and services:
Maximizer Home Page • www.maximizer.com
Maximizer BusinessNet •

biznet.maximizer.com
Maximizer List Merchant •

www.listmerchant.com/maximizer
Multiactive Australia •

www.multiactive.com.au
Multiactive U.K. • www.multiactive.co.uk
Multiactive Group • www.multiactive.com

Searching, what’s new and cool:
AltaVista • www.altavista.digital.com
Excite • www.excite.com
HotBot • www.hotbot.com
Infoseek • www.infoseek.com
LookSmart • www.looksmart.com
Lycos • www.lycos.com

Magellan • www.mckinley.com
The Mining Company • www.miningco.com
Netscape What’s New • guide.netscape.com/

guide/whats_new.html
Project Cool • www.projectcool.com
Webcrawler • www.webcrawler.com
Yahoo! • www.yahoo.com

Online promotional resources:
E-Zine List • www.meer.net/~johnl/

e-zine-list
The Liszt • www.liszt.com
NetPOST • www.netpost.com/speaking/

wd98/session1.html
PAML • www.neosoft.com/internet/paml
Yahoo! Submissions • www.yahoo.com/info/

suggest
Directory List • www.yahoo.com/

Computers_and_Internet/Internet/
World_Wide_Web/Searching_the_Web/
Web_Directories

Search Engine List • www.yahoo.com/
Computers_and_Internet/Internet/
World_Wide_Web/Searching_the_Web/
Search_Engines

Announce Site List • www.yahoo.com/
Computers_and_Internet/Internet/
World_Wide_Web/Searching_the_Web/
Indices_to_Web_Documents/What_s_New

Newsletter List • www.yahoo.com/
Computers_and_Internet/Internet/
Newsletters

ZineRack • www.zinerack.com

Graphics resources and software:
Adobe Photoshop • www.adobe.com/

prodindex/photoshop
Corel Photo-Paint • www.corel.com/

products/graphicsandpublishing/
photopaint8

Macromedia Fireworks •
www.macromedia.com/fireworks

New Riders Publishing • www.newriders.com
Peach Pit Press • www.peachpit.com
Paint Shop Pro • www.jasc.com/psp5.html
QBullets • www.matterform.com/

qbullets
Lynda Weinman • www.lynda.com/

books.html
Xoom Web Clip Empire • xoom.com/

xoom/web_clip_empire

More E-Commerce and low-cost
Web site building information:

Poor Richard’s Web Site •
www.poorrichard.com
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